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INTRODUCTION

Welcome to Mastercam 2019!Mastercam 2019 features new functionality focused on delivering speed and effi-
ciency to your machining jobs.

Release Highlights
Listed below are a few of the highlights of this release, including new toolpaths and enhanced functionality.

l "NewDeburr Toolpath"on page 73

l "NewModel Chamfer Toolpath"on page 64

l "PrimeTurning™ Toolpath"on page 80

l "New Solid Hole Function"on page 49

l "3D Tool Support"on page 75

l "Advanced Toolpath Display"on page 11

WARNING: Screen colors in the document pictures were modified to enhance image quality; they may not
match your Mastercam settings or results. These color differences do not affect functionality.

Mastercam Resources
Enhance your Mastercamexperience by using the following resources:

l Mastercam Documentation—Mastercam installs a number of helpful documents for your version of software
in the Documentation folder of your Mastercam 2019 installation.

l Mastercam Help—AccessMastercamHelp by selecting Help, Contents fromMastercam's File tab or by press-
ing [Alt+H] on your keyboard.

l Mastercam Reseller—Your localMastercamReseller can help withmost questions about Mastercam.

l Technical Support—Our Technical Support department (+1 860-875-5006 or support@mastercam.com) is
openMonday through Friday from8:00 a.m. to 5:30 p.m. USA Eastern Standard Time.

l Mastercam Tutorials—We offer a series of tutorials to help registered users become familiar with basic
Mastercam features and functions. Visit our website, or select Help, Tutorials fromMastercam's File tab to
see the latest publications.

l Mastercam University—MastercamUniversity, an affordable online learning platform, gives you 24/7 access to
Mastercam trainingmaterials. Take advantage of more than 180 videos to master skills at your own pace and
help prepare for MastercamCertification. For more information onMastercamUniversity, please contact
your AuthorizedMastercamReseller, visit www.mastercamu.com, or email training@mastercam.com.

l Online Communities—You can find awealth of information at www.mastercam.com. For tech tips and the
latest Mastercamnews, follow us on Facebook (www.facebook.com/mastercam), Twitter
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam). Visit our YouTube channel to see
Mastercam in action (www.youtube.com/user/MastercamCadCam)!Registered users can search for inform-
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ation or ask questions on the MastercamWeb forum, forum.mastercam.com, or use the knowledgebase at
kb.mastercam.com.

Contact Us

For questions about this or other Mastercamdocumentation, contact the Technical Documentation department by
email at techdocs@mastercam.com.

What's New in Mastercam 2019—Introduction
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GENERAL ENHANCEMENTS

Listed below are general enhancementsmade to Mastercam 2019. This includes improvements to selection, gen-
eral toolpath enhancements, and other functions not specific to one product line.

Advanced Toolpath Display
Mastercamnowdisplays toolpaths with different colors, based on the move type. The following image depicts a part
with aDynamic OptiRough toolpath, with Advanced Display toggled on. This is unavailable for Wire toolpaths.

If Advanced Display is not toggled on, Mastercamdisplays only cuttingmotion and rapidmotion in different colors.

Change the display state by selecting Advanced Display on the View tab. Set these colors in the System Con-
figuration dialog box on the Advanced Toolpath Display page, which is located under Colors.

What's New in Mastercam 2019—General Enhancements



You can also set colors by selecting the dialog box-launcher for Advanced Display.

You can also change the line style, line width, and other attributes. For drill toolpaths, you can set the color, line
style, and line width of the drill tool diameter.

Use the drop-downmenu to display different sections of the toolpath. For example, if you deselect Exit Motion,
then any exit motion does not display in the graphics window.

You can also toggle the display from the ToolpathsManager.

What's New in Mastercam 2019—General Enhancements
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Classic Backplot andMastercam Simulator display the customized toolpath colors if the Advanced Display toggle is
on. If it is not, the default colors display.

Analyze Enhancements
Listed below are enhancementsmade to Analyze functions, located on the Home tab.

Analyze Distance

After you select the first entity, the Analyze Distance dialog box dynamically updates the distance as youmove
your cursor. This small change allows you to sample different positions on the screen with approximate distances
without requiring you to click a second point or restart the function.

What's New in Mastercam 2019—General Enhancements



Analyze Toolpath

When using Analyze Toolpath, you can now choose to display the tool and tool holder as shaded or wireframe entit-
ies. You can also control the opacity of the tool and holder when they are displayed in shadedmode.

Block Drill Support
Mastercam Simulator and Classic Backplot nowproperly support Block Drill toolpaths. This includes support for
drillingmultiple holes simultaneously.

Mastercam Simulator, using Verify:

Mastercam 2018 Mastercam 2019

What's New in Mastercam 2019—General Enhancements
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Classic Backplot:

Mastercam 2018 Mastercam 2019

Bounding Box
In previous versions of Mastercam, you could only create a bounding box in the current construction plane. In
Mastercam 2019, four newoptions allow you to define a different bounding box orientation without having to
change the construction plane. They are listed below:

l Construction plane: Aligns the bounding box relative to the construction plane. (Default)

l Auto: Aligns the bounding box relative to the largest, flattest face of the selected solid body.

l Face: Aligns the bounding box relative to a selected solid face.

l Manual: Use a gnomon to orient the bounding box.

These options are available on the Advanced tab.

Capture Images
You can now create additional graphics for your ActiveReports setup sheet from the graphics window view. Includ-
ing these images lets you highlight areas that are complex or require special attention. Mastercamdoes not limit
the number of custom images you can add to a setup sheet.

What's New in Mastercam 2019—General Enhancements



Select Add Images on the Setup Sheet dialog box to add custom images to your setup sheet. You can preview all of
your custom images, edit captions, and add additional images fromany location accessible by your system in the Act-
iveReports setup sheet.

Changes to Files, Options
The Options page in the Options dialog box, accessible from File, Options, has been updated to include several
new features.

Deselecting Enable ribbon access keys hides the access keys that appear above a tab when you press the [Alt]
key. This option is on by default.

You can select which Quick Masks you want to appear in the graphics window. Deselect aQuick Mask to hide it.

What's New in Mastercam 2019—General Enhancements
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Dynamic Gnomon Settings
The Gnomon Settings dialog box controls the behavior of the gnomon inDynamic Planes or Transform
Dynamic. Newoptions have been added to enable a translucent plane grid, as well control the size and opacity.

Access this dialog box by right-clicking the dynamic gnomon in the graphics window.

File Support Enhancements
Listed below are enhancementsmade to Mastercam to support other CAD tools.

AutoCAD Paper Spaces Support

In previousMastercam versions, when you imported AutoCAD files (DWG, DXF)withmultiple drawing layers (Paper
Spaces) into Mastercam, the model space and only one Paper Space were imported. To see that Paper Space, you
needed to unblank your part.

Mastercam 2019 now supports the import of all of your Paper Space layouts and automatically converts them into
viewsheets. As a result, Blank Paper Space Entities has been removed from the System Configuration dialog
box and the DWG/DXF Read Parameters dialog box.

Export STEP Options

When saving aMastercam file as a STEP file, you can specify a STEP application protocol. Select Options in the Save
As dialog box to set the application protocol.

What's New in Mastercam 2019—General Enhancements



Files that are saved with the 242 application protocol (AP242) retain 3D annotation information. If you choose
another application protocol, you lose this information.

Import ProE/Creo Files with B-Rep Data

When importing ProE/Creo files into Mastercam 2018, Mastercamwould use the Parasolid data. Due to customer
comments, Mastercamnowprovides an option to use the import method prior to Mastercam 2018, which uses the
solid's Boundary Representation (B-Rep) data.

You can choose which of these methods to use when converting ProE/Creo files. Select the Use B-Rep mapping for
ProE/Creo files option on the Converters page of the System Configuration dialog box to change the default
behavior.

What's New in Mastercam 2019—General Enhancements
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This option is also available in the ProE/Creo Read Parameters dialog box. Select Options when you open a
ProE/Creo file. This allows you to override the default when converting individual files.

Model Based Definition Presentation Data Support

MastercampreservesModel Based Definition (MBD) datawhen you import solidmodels that have used the applic-
ation protocol AP242. This helps to preserve design intent when youmove your work fromaCAD package (Creo,
NX, CATIA V5, or AutoDesk Inventor1 ) into Mastercam.

Upon import, Mastercam converts any user-defined views in the imported file into a viewsheet. All presentation
data (such as annotations and dimensions) that belong to that view are preserved and displayed in that view.

When using Analyze, Mastercam classifies imported presentation data as 3D Annotation entities. They can be
deleted, transformed, or included within a bounding box. Although they might resemble Mastercam's own dimen-
sions and notes, you cannot edit or create 3D Annotation entities inMastercam.

Parasolid

Mastercamnow supports Parasolid 30.0. Wireframe and surface entities are also now included when exporting files
to Parasolid.

SolidEdge Support

Mastercamnow imports surfaces, solids, andmultiple body types contained in SolidEdge parts.

1 AutoDesk Inventor must be installed.

What's New in Mastercam 2019—General Enhancements



Unigraphics NX

Mastercamhas been updated to support the import of Unigraphics NX 12 files.

Files with Multiple Data Streams
Mastercamnowhandles SOLIDWORKS files that contain data frommultiple versions of Mastercam. When you open
a file that contains data frommultiple versions, you can choose a stream that is compatible with your version of
Mastercam. Mastercam then saves that streamand purges other data streams in that file.

The Multiple Data streams dialog box also displays if the datawas created by Industrial or Educational users, in
addition to the different versions of Mastercam. Mastercamonly saves the data to the version and user type that
you are running. Data streams that differ only by user type are not purged from the file.

For example, if you are an Industrial user:

l You only have access to the Industrial data streams.

l If you select the 2018 stream, it is saved to the current version of Mastercam.

l The 2017 stream is purged.

l The Educational stream remains in your part, unchanged.

When you save the SOLIDWORKS file, the Mastercamdata is saved to the current Mastercam version based on the
current user type.

What's New in Mastercam 2019—General Enhancements
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Guided Chaining for Partial Chaining
Guided chaining, which was introduced inMastercam 2018, is now available for most toolpath types when using Par-
tial chaining on the Chaining dialog box.

When a branch point is reached, a red arrowdisplays pointing in the direction of the default next direction/entity.
One or more blue arrows display, pointing in the direction of alternate branches, as shown in the following example.

Use the following controls with guided chaining:

Use Next to continue in the direction of the red arrow.

Use Adjust to select a different direction/entity.

Alternately, click the red or blue arrow to advance the chain in that direction. Lathe toolpaths do not support partial
chaining.

Levels Enhancements
Listed below are enhancementsmade to levels and to the Levels Manager.

Pasting Entities to a Level

You can nowuse the Clipboard commands, located on the Home tab, to cut or copy selected entities in the graphics
window to a level.

What's New in Mastercam 2019—General Enhancements



Use Paste entities in the Levels Manager right-click menu to paste the cut or copied entities to the selected level.

Turn All Levels On and Off

The Turn all levels on and Turn all levels off buttons in the Levels Manager now toggle the functions as follows:

l Select Turn all levels on the first time tomake all levels visible. The button remains toggled on and Turn all
levels off toggles off.

l Select Turn all levels on a second time to turn all levels to their visible state prior to pressing the button.
Turn all levels on toggles off.

l Select Turn all levels off the first time to turn off the visible state of all levels. The button remains toggled
on and Turn all levels on toggles off.

l Select Turn all levels off a second time to return all levels to their visible state prior to pressing the button.
Turn all levels off toggles off.

What's New in Mastercam 2019—General Enhancements

22



23

Mastercam Simulator
Listed below are enhancementsmade to Mastercam Simulator, available from the ToolpathsManager and Machine
tab.

Axis Control

Axis Control, which is available when using Simulation mode inMastercam Simulator, has been enhanced. This
panel can be toggled on by selecting Axis Control on the View tab.

The Axis Controller pane manually moves the axes. Use the sliders and buttons to jog the axes. Use this to check if
the machine limits are set correctly or for collision checking. If necessary, use Reset All to return all options to their
default setting and components to their default position.

Capture/Replay

You can now stop your verification partway through processing, and rewind the progress to showmaterial being
added back onto the part. Capture/Replay is only available for Verify mode.

To use Capture/Replay, youmust first turn on the option and then run through the simulation.

What's New in Mastercam 2019—General Enhancements



Once simulation is complete, you can use the Playback bar to move forward and backward to watch asmaterial is
removed or added.

Color Loop

More colors have been added to Color Loop for Mastercam Simulator. In Mastercam 2018, there were only 12
available colors. InMastercam 2019 there are now 18 colors.

You can also now choose to loop By Operation or By Tool number from the Color Loop drop-down on the Verify
tab. These options have been removed from the Options dialog box.

What's New in Mastercam 2019—General Enhancements
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Display or Hide Machine Housing

When in Simulation mode, you can now toggle the state of the Machine Housing to On, Off, or Translucent.

Set this option on the Home tab, in the Visibility group.

What's New in Mastercam 2019—General Enhancements



Save Tool as Wireframe or Mesh

Mastercam Simulator, when in Backplot mode, allows you to save your tool as wireframe or as amesh.

Select Save Tool on the Backplot contextual tab to set your options.

What's New in Mastercam 2019—General Enhancements
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Stop Conditions

When using Specify Values to set stop conditions, you can now select Reach or Exceed Value to stopMastercam
Simulator once you have reached or exceeded the entered X, Y, or Z value. You can set stop conditions on the
Home tab.

What's New in Mastercam 2019—General Enhancements



Timeline Zoom

Timeline Zoomhas been added to Mastercam Simulator, allowing you to zoom into the simulation timeline to see
more or less detail. This is helpful when using Bookmarks that might be close together. Timeline Zoom is toggled
on or off on the View tab.

Use the Timeline Zoom slider in the bottom left corner of Mastercam Simulator to zoom in and out of the timeline.

The Timeline in the bottom right corner of Mastercam Simulator displays the total timeline of the simulation. The
highlighted section displays the zoomed section. You can also move the highlighted section by sliding it forward and
backward.

If you toggle Timeline Zoom off, the simulation returns to its default setting. If you toggle Timeline Zoom back
on, it remembers your zoom setting and applies it based on the location of the simulation. This only applies per each
session of Mastercam Simulator.

What's New in Mastercam 2019—General Enhancements
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Toolpath Analysis

Toolpath Analysis is now available when using Simulation mode inMastercam Simulator. Select Toolpath Analysis
on the View tab to display the Toolpath Analysis panel.

Toolpath Analysis analyzes changes to toolpaths by applying color schemes. Choose from the following options:

l Operation: Colors each toolpath differently.

l Tool: Colors toolpaths when different tools are being used.

l Feed Rate: Colors toolpaths by feed rate and rapidmoves.

l Segment Length: Colors toolpaths based on the length of the segments.

Material Display
Material on the View tab controls the display of an assignedmaterial on shaded entities. Toggling Material on
showsmaterials that have been applied to entities. Toggling Material off returns the entities to their default
appearance. Material display is not available inWireframe mode.

Metal Plastic Glass

What's New in Mastercam 2019—General Enhancements



You can apply ametal, plastic, or glassmaterial to an entity. Eachmaterial has seven levels ranging frommost trans-
lucent to most opaque. Applying amaterial to an entity also togglesMaterial view for the file.

This is set on the Home tab in the Attributes group, or from the right-click menu in the graphics window.

You can also set the material when creating a stockmodel, on the Stock Definition page.

Nesting Enhancements
Listed below are enhancementsmade to toolpath and geometry nesting.

MCLink INI Files

You can open and save MCLink's ATP-generated .INI files from the Toolpath Nesting dialog box. MCLink is a
MastercamRouter utility. MCLink nesting is amethod of running a set of nested parts and toolpaths that were out-
put by the Automatic Toolpathing (ATP) add-on.

For a detailed procedure on how to open and save .INI files, please read About Toolpath Nesting in the Mastercam
Help.

What's New in Mastercam 2019—General Enhancements
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Order of Operations

You can now reorder operations within an operation cluster when using Toolpath Nesting. This option is only avail-
able if you have selected None as your sortingmethod.

Right-click on the operation cluster and select Order of operations.

The Order of operations dialog box then displays, and lists all operations in the selected cluster. You can then use
the dialog box to change the order of the operations.

After Mastercamhas sorted the operations, it moves any operations assigned a non-zero machining index. The
lower the machining index, the earlier the operation ismachined. The higher the machining index, the later the
operation ismachined. For example, operations that are assigned a negative machining index (such as -5 and -1) are
machined before operations not assigned to an index (such as 0). Operations assigned to a positive machining index
(such as 10 and 25) are machined after operations not assigned to an index. In that case, the machining order for six
operations would be the following: -5, -1, 0, 10, 25.

What's New in Mastercam 2019—General Enhancements



Save Color Images

The Nesting Configuration dialog box allows you to include color images in your nesting reports by selecting Color
images in reports. Toolpaths only display in color if you enable Cycle colors starting with.

Planes Enhancements
Listed below are enhancementsmade to planes and to the PlanesManager.

From Plane Displays in Color

When you select Find a plane, from plane, the plane gnomons display in the graphics window in the colors con-
figured for the planes in the PlanesManager, making it easier to identify which plane to select. To control which
planes display, use the Display column in the PlanesManager.

What's New in Mastercam 2019—General Enhancements
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Gnomon's XY Pane Displays in Color

The XY pane of the plane's gnomon can nowbe configured for each plane using Color in the PlanesManager. Dis-
playing the XY pane in different colorsmakes it easier to identify the plane in the graphics window.

What's New in Mastercam 2019—General Enhancements



Planes Axes and Grid Settings

You nowhave control over the plane gnomon’s size, as well as enabling a translucent plane grid in the Plane
Gnomon Settings dialog box.

The plane grid’s opacity and size can be configured, as well as the axes size.

What's New in Mastercam 2019—General Enhancements
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Select Plane gnomon settings, under Display options in the PlanesManager to access these options.

Quick Settings Saved as Defaults
You can choose to save any settings youmake in a dialog box launched froma tab as configuration defaults. Pre-
viously, you had to set the configuration defaults in the System Configuration pages.

The following quick settings dialog boxes will nowdisplay a prompt allowing you to save the settings to the con-
figuration file, or use them for that session only.

l Home, Attributes, Entity Attributes Manager

l Drafting, Dimension, Drafting Options

l View, Appearance, Shading

l View, Toolpaths, Advanced Toolpath Display

l View, Grid, Grid

l View, Viewsheets, Viewsheets

What's New in Mastercam 2019—General Enhancements



Section View
The PlanesManager allows you to create a section view by cutting a plane to see a section of the part.

To create a section view using an existing plane, click in the Section column of the PlanesManager on the plane you
want to use.

Section View toggle on the View tab, or Section View on the PlanesManager must be selected to show the sec-
tion view in the graphics window.

When Section View is toggled off, the section view in the graphics windowno longer displays, but the X is still dis-
played in the Section column. If Section View is toggled on, select the X in the Section column to remove that sec-
tion view if you no longer need it.

What's New in Mastercam 2019—General Enhancements
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The Section View toggle has a list of entities that can be displayed. Choosing the entity from the list enables the sec-
tion view for that entity type. The entities that can be enabled for section view include:

l Stock Models

l Shaded Entities

l Wireframe Entities

l Toolpaths

l Show Caps

Show Caps fills in the section of the part with a solid cap as shown in the following images:

Show Caps on Show Caps off

You can also create a section viewwhen creating a newplane in the New Plane function panel. Section Viewmust
be toggled on to be live during plane creation and editing. Select Section under Set As to set the newplane as the
section view.

What's New in Mastercam 2019—General Enhancements



You can save a section view plane and its settings as part of a viewsheet. These options are set in the Viewsheet
page, under Screen in the System Configuration dialog box. When you select this option, the section state for
each newplane is saved within the viewsheet.

Selection Enhancements
Listed below are enhancements for how you select entities inMastercam 2019.

Glow Highlighting

Entities have a glowhighlight when you hover over or select them in the graphics window.

What's New in Mastercam 2019—General Enhancements
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You can enable glow highlighting by selecting Use glow highlighting on the Screen page in the System Con-
figuration dialog box.

l

Change the auto highlight glow colors on the Colors page of the System Configuration dialog box.
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Mesh Node Selection

AutoCursor now recognizes the endpoints of Mastercammesh vertices. Mastercam recognizes positions on all
mesh vertices, or on vertices that reside alongmesh edges. This increases flexibility during CAD creation and dimen-
sioning.

You configure howAutoCursor snaps to mesh vertices in the AutoCursor Settings dialog box. Select Mesh Ver-
tices only to enable snapping to all mesh vertices. Select Along Edges Only to only include mesh vertices that
reside on the edges of the mesh.

Toolpaths Manager Display Options
The state of the Only display selected toolpaths nowpersist acrossMastercam sessions. The state persists
whether it is set from the ToolpathsManager or the Quick Access Toolbar.

What's New in Mastercam 2019—General Enhancements
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Viewsheet Enhancements
There are seven newoptions in the Viewsheets page in the System Configuration dialog box, or by right-clicking
a viewsheet tab and selecting Settings.

You can save planes used to create section views by selecting Section view planes. Selecting Section view set-
tings allows you to save the default options. Please see "Section View"on page 36 for more information on section
views.

Viewsheet settings also include a new Stock display setting. Viewsheets can save multiple stock display settings for
Lathe andMill-Turn parts, but can only save a single stock display setting for Mill and Router parts.

If you have a 3Dconnexions device, you can save the current rotation position in a viewsheet. Select the Motion
controller rotation position.
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Wireframe Tool Display
When using Classic Backplot, you nowhave the option to display the tool as wireframe, or shaded.

You set this option in the Backplot Options dialog box, by selecting Shaded or Wireframe under Tool Render
Style.

What's New in Mastercam 2019—General Enhancements
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DESIGN ENHANCEMENTS

Listed below are enhancementsmade to design functions, such as Cross Hatch, Push-Pull, and Point Nodes.

Drafting Enhancements
Listed below are enhancementsmade to functions on the Drafting tab, including Cross Hatch and Note.

Cross Hatch

In previous releases, you had to exit Cross Hatch if you wished to re-chain geometry. A Reselect button has been
added to allow you to re-chain geometry without leaving the function.

Drafting Associativity

A new function, Associativity, has been added to Mastercam that showswhich dimensions are associated to geo-
metry. Access this function by selecting Associative under Validate on the Drafting tab.
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Once you have entered the function, select the drafting entities you wish to check, and then press [Enter] or select
End Selection.

Mastercamdisplays dimensions that are associative with the Result color (purple) and dimensions that are not asso-
ciative with the Group color (red). Rolling your mouse over associative dimensions highlights the geometry it is asso-
ciative to. Mastercamalso displays howmany selected dimensions are associative.

What's New in Mastercam 2019—Design Enhancements
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Note Height

Use Select Height in the Note function panel to quickly change the height of your note text to be the same as
another note. Select the button, and then select a note from the graphics window. The Height parameter updates
to match the height of the selected note.

On-screen Triggers

When you dimension an arc or a circle, small triggers appear in each quadrant of the arc or circle and offset from
outside of the arc or circle in 45 degree increments. You can use these triggers to switch between creating tangent
and circular dimensions.

Hover over a quadrant trigger to create a tangent dimension, as shown below:
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Hover over an offset trigger to create a circular dimension, as shown below:

Solids and Model Prep Enhancements
Listed below are enhancementsmade to the functions located on the Solids and Model Prep tabs, including Push-
Pull and Hole Axis.

Boolean

Since the introduction of the function panel interface, some users experienced delays with Boolean when they
selected a complex part withmultiple operations and/or tool bodies.

InMastercam 2019, we have changed the workflow for Boolean to minimize processing time. You no longer need
to select the target body and the tool body to display the function panel and edit the settings. The function panel
nowdisplays as soon as you enter the function.

Chamfer

InMastercam 2019, you can chamfer entities, such as holes in cylinders, where the angle of the newly created cham-
fer face will vary.

Disassemble

Disassemble now supports the selection of cylinders, cones, and other solidmodels without flat faces.
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Hole Axis

Hole Axis has several enhancements for Mastercam 2019. You can now include tapered holes in your selection, as
well as have the function draw vectors for holes that you will spot drill. Additionally, a newAll Holes button selects
of all the holes in your part with one click.

Once you create your axis lines, use the Advanced tab to change how the axis lines look and their level location.

Mastercamalso nowdisplays the diameter of the hole in the graphics window instead of its radius.

New Align Functions

Two new align functions are available on the Model Prep tab, and Position has been renamed to Align to Face.

Align to Face

Align to Face uses the dynamic gnomon to control orientation whenmating solidmodels. This is useful for aligning
inserts to holders when creating 3D tools. To learnmore about 3D tools, please see "3D Tool Support"on page 75.

After placement, you can adjust it even further with the dynamic gnomon. Align to Face allows you to work in three
modes: Coincident, Perpendicular, and Parallel.

Coincident allows you to copy or move a solid by mating a face on the solid to another solid's face. Parallel and Per-
pendicular require you to select a linear edge on the solid body that is beingmoved and on the target solid body.
When you select a linear edge on the solid body that is beingmoved, Mastercamaligns the X axis of the gnomon to
that edge. When you select an edge on the target body, Mastercamaligns the X axis of the solid beingmoved to be
perpendicular or parallel to that edge.
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Align to Face also supportsmating cylindrical faces. After you select the faces, Align to Face rotates each body
into position andmates each face at its center. It rotates the object into position, if the bodies are not in same plane
or of the same radius.

Align to Z

Align to Z aligns a solid body that is used for a turning operation to a newWCS or an existing construction plane
along the Z axis. This lets you orient the body so that is ready to machine. This function is also located on the Lathe
Turning contextual tab.

Align to Plane

Align to Plane aligns a solid body to a newWCS or an existing construction plane. You can align an edge of the solid
to the X axis of the plane or WCS, and a selected point on the solid to the origin of the WCS or plane.
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New Solid Hole Function

A new function called Hole is now available on the Solids tab. This function automates the punching of cylindrical
holes in primitive solids, saving you from creating circles and extruding them.

Set the hole dimensions and the hole type. You can create a simple cylinder or select from the following hole types:

l Counterbore

l Countersink

l Counterdrill

l Taper

Click in the graphics window to place it on the solid. Press [Enter] to view the newhole. The hole remains live, and
you can place copies of it on the part or modify any of its parameters until you exit.

Create and save commonly used holes in a preset library. You can use these presets in future sessions of Master-
cam. Mastercam converts hole dimensions stored in a preset library to the current units (inch to metric, or metric to
inch).
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The SolidsManager displays this function's operations.

Push-Pull

You can nowuse Push-Pull to create solid bodies fromopen, closed, and nested wireframe geometry, as well as
sheet bodies.

Once inside the Push-Pull function panel, click Select under Chaining to bring up the Chaining dialog box. Select
the wireframe youwish to create a solid body from, and click OK. You can then use the control arrow in the graphics
window to create a solid body.

Push-Pull also supports surfaces. You can select a single surface and use the arrow to create a solid body, or grab
connected surfaces to move as a single sheet. A newoption, Maintain source surfaces, prevents the original sur-
faces frombeing absorbed and deleted.
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Solids Manager

SolidsManager includes neworganization features. These improvements include:

l You can now create multiple solid groups to hold bodies. Additionally, you can edit these groups andmove
them, reorder them, or delete the bodies inside them. Rename the groupswith a slow double-click. Use
[Shift+click] and [Ctrl+click] to move multiple solid bodies in and out of groups.

l Even when a group folder isminimized, the folder icon displays the state of the solid bodies within it.

l The toolbar now includes several options that were previously only available from the right-click menu.

l In the right-click menu, Analyze Entity Properties has replaced Attributes so you can quickly get more
information on a selected body.

Surface Enhancements
Listed below are enhancementsmade to functions on the Surfaces tab, including Surface From Solid and the new
Edit Surface function.

New Edit Surface Function

A new function, Edit Surface, is now available on the Surfaces tab.
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Edit Surface allows you to make edits to existing surfaces. It worksmuch like the Edit Spline function that was intro-
duced inMastercam 2017. You canmodify the tangenices andmagnitudes of the curve at nodes points, or edit tan-
gencies at the vectors of control points. You can also add or remove node points and isocurves to increase your
editing control and to make finer adjustments.

Edit Surface includes tools that allow you to assess and analyze the surface you are working on. You can add or
remove the visibility of flowlines along the U or V axes. Curvature combs represent the curvature of the surface and
display curvature continuity or discontinuity.

Power Surface

A new function, Power Surface, is now available on the Surfaces tab in the Create group. Power Surface gives
users the capability of easily creating surfaces from curves and influenced by adjoining surfaces.
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After you have selected the curves needed to crate a new surface, the Power Surface function panel displays allow-
ing you to edit the create surface.
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Surface From Solids

The selection options that were available inMastercam 2018 are now available when using Surface from Solids on
the Surfaces tab. You can nowuse the following short-cut keys:

l [Shift+click] to select tangent solid faces.

l [Alt+click] to select a vector.

l [Ctrl+click] to select matching solid fillets and holes.

l [Ctrl+shift+click] to select similar solid faces.

l Double-click to select a solid feature.

l Triple-click to select the solid body.

Wireframe Enhancements
Listed below are enhancementsmade to functions on the Wireframe tab, including Point Nodes and Join Entities.

Curve One Edge and Curve All Edges

Curve One Edge and Curve All Edges support creating edge curves onmesh files.
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New Divide Function

Divide has been broken out from the Trim Break Extend function into its own function, and withmore func-
tionality. Divide is located on the Wireframe tab.

As with previousMastercam versions, you have the option to use Divide to trim or break entities. You can also now
hold down the left mouse button and use it to trim or break entities as your mouse encounters them.
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Join Entities

Join Entities (located under Trim Break Extend on the Wireframe tab) nowdisplays as a function panel. This allows
you to domultiple operations without having to reenter the function.

Offset Chains

The workflow for Offset Chains has also beenmodified. In previous versions, the chaining direction determined
the offset. Now, you are prompted to set the side and distance of the offset by clicking in the graphics windowor by
selecting an AutoCursor position.

On-screen Controls

Create Letters and Bolt Circle use the origin, polar, and linear on-screen controls that were previously only avail-
able when using Stretch or translation functions.
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You can change the origin by clicking on the center ball andmoving it. Click on the arrow and drag it in or out to edit
the radius. Click on the blue circle to change the start or rotation angle.

Point Nodes

Point Nodes no longer creates points on the control points of a spline.

Mastercam 2018 Mastercam 2019

Spline Blended

Spline Blended now includes newdirection controls that allow you to change the magnitude of each spline. Addi-
tionally, you can now trim or break either or both splines.
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MILL ENHANCEMENTS

Listed below are enhancementsmade to the Mill product, including improvements to the 2D, 3D, andMultiaxis
toolpath types.

Check Holder
Check Holder, which was previously an Add-In in earlier Mastercam releases, is now integrated withMastercamand
has been improved. Use Check Holder to check an operation's tool holder for interference with the part. It cal-
culates areas where there are interferences between the holder and the part, and tells you the minimum tool
length required to avoid it. Before starting Check Holder, you should select the desired operation in the Toolpaths
Manager.

Check Holder is located on the Mill Toolpaths contextual tab.
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Mastercam's Accelerated Finishing™

Mastercam's Accelerated Finishing technology addresses today's finishing tool geometries and processes, resulting
in greater efficiency and higher machining productivity when usingMill. To support this, Mastercamhas added two
new tool types, Lens Formand Taper Form. Barrel Mill has beenmoved to the Accelerated Finishing group, and addi-
tional variations of this shape are now available.
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Lens Formand Taper Form are based on Barrel Mill tools, with new tip and profile dimensions.
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New Point Selection Workflow
When you select point geometry for Mill, Router, and CannedWire toolpaths, the new Toolpath Hole Definition
function panel displays, in place of the Drill Point Selection dialog box.

Use the options on the Selection tab to pick your points, andmake any changes to the sort order. Once you are sat-
isfied with your selections and options, click OK to open the toolpaths dialog box.

Skip Pocket Smaller Than
A newparameter is now available on the Transitions page for Area Roughing, Dynamic OptiRough, Waterline, Hori-
zontal Area, and 2D AreaMill toolpaths. This newparameter allows you to skip pockets based on the tool diameter
percent, rather than by entering a dedicated size of the pocket. When you enter a value for either the Tool dia-
meter percentage (on the left) or for the Minimum pocket size (on the right), the other parameter updates.
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This is helpful whenMastercam thinks that a pocket is large enough to accommodate the tool, but the entry move is
so compressed that the tool is effectively plunging into the part. If you want to ensure that the entire surface is
machined, you can set these values to 0. However, if the cutting area is too small for the programmed entry moves,
the tool will plunge straight down into the pocket.

The images below show a 2D AreaMill toolpath using a flat endmill tool with a tool diameter of 12.0 (mm)with dif-
ferent Skip pockets smaller than percentages.

Percentage amount Resulting toolpath

0%

300%

350%
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When opening a file froman older version of Mastercam, your operationsmight be marked dirty. A warning dis-
plays if this is the case.

2D Enhancements
Listed below are enhancementsmade to 2D toolpath types, such as Contour.

Miscellaneous Enhancements

l ThreadMill toolpaths now can control the entry/exit arc length anywhere from0° to 360°.

l The new End of Center option on the Lead In/Out page allows you to end the toolpath at the center of the
selected arc.

Maintain Sharp Corners

A new field, Maintain sharp corners, is now available on the Cut Parameters page for standard 2D Contour and
Pocket toolpaths. This newoption allows you to roll the toolpath around sharp corners. It is available when you
enter a positive value for Stock to leave on walls.

l Roll cutter around corners
set to Sharp.

l Stock to leave on walls set to
0.0.

l Maintain sharp corners is not
selected.

l Roll cutter around corners
set to Sharp.

l Stock to leave on walls set to
0.175.

l Maintain sharp corners is not
selected.

l Roll cutter around corners
set to Sharp.

l Stock to leave on walls set to
0.175.

l Maintain sharp corners is
selected.
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New Model Chamfer Toolpath

A new toolpath is now available for 2D machining. The Model Chamfer toolpath allows you to machine safe hori-
zontal chamfers on solidmodels. Model Chamfer only supports the following:

l Chamfer mill tool type

l Solid edges and faces for Chain geometry

l Surfaces, solids, andmeshes for Avoidance model

After selecting your Chain geometry, Model Chamfer has several unique parameters to further control the
toolpath. You can enter a Side clearance for the Solid model, which is the distance away from the solidmodel you
want the vertical part of your flute to clear. This option is set on the Toolpath Type page.
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On the Cut Parameters page, you can set aChamfer width value allowingMastercam tomeasure the width from
the chained geometry adjusted by the cut depth defined on the Linking Parameters page. Use Top offset to
define how far the full diameter of the tool is above the top rail of the chamfer and use Bottom offset to define
how far the tip of the tool is from the bottomof the chamfer.

Select Model Chamfer from the 2D gallery in the Mill Toolpaths contextual tab.
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3D Enhancements
Listed below are enhancementsmade to 3D toolpath types, such as Hybrid.

Area Roughing Improvements

The linking processing time for Area Roughing toolpaths has improved, specifically for parts withmany pockets and
small stepdowns. This improves the overall processing time for high-speedmachining applications that use Highfeed
endmills. These tools typically use a smaller stepdown—for example, 10% of the tool diameter—which can generate
many pockets to sort. You can see in the following images that the processing time for this toolpath is reduced
betweenMastercam 2018 andMastercam 2019.

Mastercam 2018
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Mastercam 2019

New Equal Scallop Toolpath

Mastercam2019 introduces a new 3D high speed toolpath, Equal Scallop. This new toolpath creates a consistent scal-
lopmotion relative to stepover distance. Equal Scallop produces a superior surface finish compared to 3D HST Scal-
lop.
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Equal Scallop generates clean, noise-free motion with the ability to smooth out sharp corners, or convert the motion
to a spiral approach while avoiding stepover moves.

Equal Scallop supports avoidance geometry and Projected boundary smoothing tolerance, which was also intro-
duced in this release. For more information, please read "Smoothing Tolerance"on the facing page.

There are two parameters that are specific to Equal Scallop, both available on the Cut Parameters page. Spiral elim-
inates stepovers whenmachining. Smoothing attempts to smooth sharp corners and replaces themwith curves,
resulting in amore even load on the tool.

Select Equal Scallop from the 3D gallery on the Mill Toolpaths contextual tab.
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Smoothing Tolerance

A newoption, Projected boundary smoothing tolerance, has been added to the Toolpath Control page for
Hybrid and Equal Scallop toolpaths.

When you project a containment boundary onto the machiningmodel, the resulting projected boundary can be
jagged or noisy, especially near steep features. Use this option to allowMastercam to improve the quality of the pro-
jected boundary.
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Without tolerance With tolerance

When you use this option with the new Equal Scallop toolpath with avoidance geometry and no containment bound-
ary, Mastercamattempts to smooth the border between the machining and avoidance geometry if it is jagged or
noisy.

Transitions Feed Rate

You can now set which feed rate is used during transitionmoves for Waterline toolpaths on the Transitions page.

l Plunge rate: Uses the Plunge rate set on the Tool page for transitionmoves.

l Feed rate: Uses the Feed rate set on the Tool page for transitionmoves.

Multiaxis Enhancements
Listed below are enhancementsmade to Multiaxis toolpath types.

Miscellaneous Enhancements

l Output from Swarf Milling toolpaths can nowbe locked to 4-axis, even if it deviates from the surface.

l You can now select a plane with the Select Plane button in the 3-axis Select Tool Plane dialog box.

l You can now set the Pattern to Dynamic when using Roughing for Port Expert toolpaths. This option is avail-
able on the Cut Pattern page whenOutput format on the Tool Axis control page is set to 4 Axis.

l Returned the ability to choose a named plane as a view direction.

l Scallop Height is now enabled for Morph toolpaths, as well as any other toolpath that supports it.
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Gradual Front Shift

Morph and Parallel toolpaths now support a gradual Front shift, which keeps the tool in better contact with the part
without placing excess wear on the tool's leading and trailing edges. Without gradual front shift, the tool cuts across
the part with the tool's edge, as shown in the following images. Front shift is located on the Tool Axis Control
page.

The first image shows the tool starting its cut on the edge of the tool.

The second image shows that the tool has cut across the entire arc with that edge.
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The images below show the same cut using gradual front shift. The first image shows the tool entering the cut, the
second image shows the tool shifted to use the center of the tool, and the third image shows the tool near the end
of its cut, with the opposite edge of the tool cutting.

Multi-Threading

Curve, Swarf, Flow, Multisurface, Port, and Rotary toolpaths are nowmulti-threaded, which letsMastercamoperate
while the toolpaths regenerate. Youmay experience speed improvements inmultiple and offset cut calculations.

If necessary, multi-threading can be turned off by selecting Disable for Classic Multiaxis toolpath mul-
tithreading on the Toolpath Support page in the Mastercam Advanced Configuration dialog box.
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New Deburr Toolpath

A new toolpath is now available for Multiaxis. Deburr is used to break edges for 3-to-5 axis, and to remove burrs.

The Deburr toolpath can be used with the following tools:

l Ball endmill

l Lollipop with undercut
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Select Deburr from the Multiaxis gallery in the Mill Toolpaths contextual tab.
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LATHE ENHANCEMENTS

Listed below are Lathe enhancementsmade to Mastercam 2019.

3D Tool Support
Mastercamnowallows you to build tools from 3D STEPmodels, using the new Tool Designer. To create a 3D tool,
select Create 3D tool from the right-click menu in the Lathe Tool Manager dialog box.

The Tool Designer is a function panel with tab-style navigation, providing a structured workflow that is similar to
using awizard. You can define tools, assign them to operations, and view themwhen running Classic Backplot and
Mastercam Simulator.
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Improved Support for Cross-Centerline Turning
Support for cross-centerline turning has improved. When you select a tool or turret that is across the centerline
from the chained geometry, Mastercam reverses the spindle direction of the operation. Earlier versions of Master-
cam required you to artificially mount the tool in the opposite turret. This is no longer necessary.

Mastercamalso includes new validation routines that prevent you from creating a cross-centerline toolpath in situ-
ations where it does not make sense, such as for a pinch-turning toolpath.

What's New in Mastercam 2019—Lathe Enhancements

76



77

Mastercam Lathe for Swiss Machines
Note: Lathe for SwissMachines is only available in the United States.

Mastercam 2019 now supports Swissmachines through its familiar Lathe solution. Swiss users with active Lathe and
Mill/Mill 3D licenses can now take advantage of familiar Lathe andMill toolpaths. Mastercamprovidesmilling, groov-
ing, and engraving strategies usingmilling tools.

A wide variety of post processors are available to support Mastercam Lathe for Swiss. These post processors are cre-
ated andmaintained by our Mastercampartners, Postability, Inc. and In-House Solutions, Inc. Currently there are
posts for many of the 5-7 gang-style Swissmachines now available in the Unites Statesmarket.
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After creating your part, you can use Mastercam Simulator and Classic Backplot to simulate the toolpaths.

Multiple Plunge
The Lathe Groove toolpath includes aMultiple Plunge option, allowing you to rough out a groove with rib cuts, as
shown below:

This is useful when you are concerned about tool deflection. Consistent tool pressure can result in better chip con-
trol, andmore even tool wear. Multiple Plunge also gives you the option to machine the ribs with amore aggress-
ive feed rate than the initial plunges.
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To activate the newoptions, check and select Multiple Plunge on the Groove rough parameters tab.

Use the Multiple Plunge Parameters dialog box to configure the rib cuts, such as the direction, plunge feed rate,
plunge spindle speed, or the rib width.
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PrimeTurning™ Toolpath
The PrimeTurning toolpath, which was introduced inMastercam 2018 as an Add-In, is now fully integrated into
Mastercam. Select PrimeTurning on the Lathe Turning or Mill-Turn Turning contextual tab.

Mastercamhas partnered with Sandvik Coromant on the development and support of their innovative PrimeTurn-
ing™method and CoroTurn® Prime tooling. With these tools andmethods, Mastercamallows you to turn in con-
ventional turning and PrimeTurning directions. When combined with either CoroTurn Prime A-type or B-type
inserts, PrimeTurning provides superior metal removal rate, productivity gains of over 50%, and increased tool life
in a variety of materials.

PrimeTurning has highmetal removal rates that are the result of running the CoroTurn inserts at double the speed
and feed, compared to conventional turning strategies. These inserts utilize a chip thinning design that reduces tem-
perature at the leading edge and away from the tool nose. You experience greater chip control and increased tool
life, requiring fewer tool changes and production stops.

Improved Tool Libraries for PrimeTurning

The CoroTurn Prime tool libraries for PrimeTurning now include Sandvik's 0.4mm radius inserts. The libraries are
installed withMastercam 2019, and can also be downloaded from the Tech Exchange
(https://community.mastercam.com/techexchange) onMastercam.com.

3D Tool Libraries for PrimeTurning

With the introduction of 3D tool support ("3D Tool Support"on page 75), two 3D tool libraries are available for
PrimeTurning. One library is in inch, the other library is inmetric. These libraries can be downloaded from the Tech
Exchange (https://community.mastercam.com/techexchange) onMastercam.com.
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MILL-TURN ENHANCEMENTS

Listed below are Mill-Turn enhancementsmade to Mastercam 2019.

Adjust Tool Projection
After loading tools, you nowhave the ability to adjust the tool's projection length by dragging the tool in the graph-
ics window. In the Tool SetupManager, right-click on the tool and select Set projection length.

Mastercamdisplays the tool and its tool locator component in the graphics window. Drag the tool to the desired loc-
ation.
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Bar Feed Enhancements
The Bar Feed toolpath has been improved:

l It is now supported in Simulation.

l There are newoptions to helpmanage geometry. These include selecting geometry to move with the Bar
Feed toolpath, specifying a level for the transferred geometry, and the option to delete the original geo-
metry.

l You can select either spindle, if it is supported by the machine.

l There are newoptions to update the spindle origin, create newplanes based on the new spindle origin, or
update the work offset.

l There are newoptions for specifying the destination andmotion rate of the bar feed.

Import and Export Operations
You can import operations from Lathe andMill machine groups into Mill-Turnmachine groups. In previousMaster-
cam versions, you could only import operations fromother Mill-Turnmachine groups.

In addition, you can copy and paste, or drag and drop operations, fromMill and Lathe machine groups. Mastercam
includes validation routines to ensure that the imported or copied operations are compatible with the Mill-Turn
machine definition.
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Improved Tool Loading
The tool loading algorithmhas been improved inMastercam 2019. This is especially helpful when loading tools for
multi-station tool locators that support machining on either spindle. This also includes:

Turret tool locators can nowbe set to a specific angular orientation. InMastercam 2018, this was only supported for
spindle tool locators.

Improved Work Offset Support
Mill-Turn now supports the Automatic option for work offsets in the same way as other Mastercamproducts. You
can select Automatic as the Work offset when creating a toolpath, andMastercamwill search for the next available
offset.

New Options for Managing Collision Detection Files
Mastercam2019 improves the way collision detection files (.collision) files are managed inMill-Turn .machine
files. You nowhave the option of saving a .collision file in a .machine file, or have Mastercamgenerate one
when Simulation is starting.

l Saving a .collision file in your .machine file is recommended when you or your Reseller have customized
the .collision file.

l Not saving a .collision file is recommended if you want to ensure that Simulation uses the most up-to-date
.collision file. For example, if changes have beenmade to your machine definition.

New right-click menu options in Code Expert let youmanaged .collision files. You can choose to create a .col-
lision file from the current machine definition or select an existing .collision file, and add it to your .machine
file.

Mastercam removes the .collision files fromexisting 2018 .machine files when they are migrated to 2019. If
you want to keep the .collision file from your existing 2018 machine, make a copy of the file and use the right-
click menu options shown above to add it to your 2019 .machine file after it has beenmigrated.
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Reference Positions
The Machine Reference PositionManager now includes aNo axis motion option for linear axes that suppresses NC
output for that axis.

For example, you can create a turret park reference position that only outputs an X-axis coordinate.

Simulation Enhancements
Newoptions let you configure the Initial viewwhen Simulation is launched. You can choose from:

l One of Mastercam's standard views.

l AnOptimized view, which adjusts the Front view for a cleaner view of the work envelope.

l The most recent view from the last time you ran Simulation in the current session.

l Force reload causesMastercam to reload the machine models and other supporting files when Simulation is
launched. This ensures Simulation uses the most recent models if changes have beenmade to the .machine
file.
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These options can also be set in the Application Options dialog box, on the Simulation page under Sync
Manager.

Simulation also now reads the Translucency that is stored in the machine definition for each component.
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POST ENHANCEMENTS

Listed below are enhancementsmade to posts.

Cascading Postblocks
MP now supports cascading postblocks. This technique lets several postblock labels share the same set of postlines,
so that a call to any of the postblock labels results in the same set of postlines being executed. This can help you cre-
ate code that ismore compact, modular, and reusable.

To define cascading postblocks, simply create postblock labels on consecutive lines with no indent. After the final
postblock label, add the postlines with your processing logic.

This can be an effective technique whenever you have a postblock definition that does nothing except call a related
postblock. For example, our MPFAN.pst post includes a series of "_2"postblocks that are called for additional points
in a drill cycle. However, most of these do nothing except call pdrill_2$: 

# Additional Holes

pdrill_2$ #Canned Drill Cycle, additional points

pdrlcommonb

pcan1, pbld, n$, pxout, pyout, pzout, pcout, prdrlout, feed, strcantext, e$

pcom_movea

ppeck_2$ #Canned Peck Drill Cycle

pdrill_2$

pchpbrk_2$       #Canned Chip Break Cycle

pdrill_2$

ptap_2$          #Canned Tap Cycle

pdrill_2$

pbore1_2$        #Canned Bore #1 Cycle

pdrill_2$

pbore2_2$        #Canned Bore #2 Cycle

pdrill_2$

pmisc1_2$        #Canned Fine Bore (shift) Cycle

pdrill_2$

Using cascading postblocks, you can write the same logic as:

# Additional Holes

pdrill_2$ #Canned Drill Cycle, additional points

ppeck_2$ #Canned Peck Drill Cycle
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pchpbrk_2$ #Canned Chip Break Cycle

ptap_2$ #Canned Tap Cycle

pbore1_2$ #Canned Bore #1 Cycle

pbore2_2$ #Canned Bore #2 Cycle

pmisc1_2$ #Canned Fine Bore (shift) Cycle

pdrlcommonb

pcan1, pbld, n$, pxout, pyout, pzout, pcout, prdrlout, feed, strcantext, e$

pcom_movea

Before you can use cascading postblocks in your post, they must be enabled with the x_mp_adv_func$ switch. This is
a "license-plate"variable where each digit controls a specific advancedMP processing routine. Support for cascading
postblocks is turned on by digit 2, the 10's place:

x_mp_adv_func$ : 10 # Enable cascading postblock support

The x_mp_adv_func$ switch is typically initialized immediately after the header line, before any other variables.

NCI Updates
MP developers should note the following newNCI data for Mastercam 2019:

l A newparameter, number 20, has been added to the end of the 1016 line. A newpredefined variable,
link_op$, has been defined to store its value. It indicates that Mastercam's Safety Zone feature has been
enabled for aMultiaxis Drill operation (tool_op$ = 28).

If the Safety Zone option has been selected for aMultiaxis Drill operation, the value of link_op$will equal
155 in the null tool change section between the drill points. In all other cases (regardless of the operation
type), the value of link_op$will be the same as tool_op$.

l The following new values have been defined for tool_op$:

l 73: Lathe PrimeTurning™

l 140: Mill 2D Model Chamfer

l 459: Multiaxis Deburr

l 155 is reserved for use by link_op$ for Multiaxis Drill Safety Zone operations.

Values have also been defined for the new tool types introduced inMastercam 2019. For more information on the
tools, please read "Mastercam's Accelerated Finishing™"on page 59 and "3D Tool Support"on page 75.

l The newAccelerated Finishing tool types, Taper form and Lens form, are tool types 26 and 27. This value is
output on the NCI 20004 line (parameter 2) and also saved to the tool_typ$ value (NCI 1016 parameter 2).

l 3D Lathe tools are output with the same NCI structure as existing custom tools. The value is based on the
insert type. It is output on the NCI 20100 line (parameter 2) and also saved to the tool_typ$ value.

l 3D turning tools are output as tool type 50.

l 3D threading tools are output as tool type 51.

l 3D grooving/parting tools are output as tool type 52.
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New MP Function for Regular Expressions
Mastercam2019 includes a new regex( ) function for MP that searches a string to match a regular expression. Regu-
lar expressions let you apply patterns when searching text strings. The pattern can be as simple as a literal string, or
can include wild cards, optional characters, and other expressions.

You can configure the function to either:

l Return a string that matches the expression.

l Modify the source string based on the regular expression.

The general form is:

string1 = regex (expression, string2, n)

where,

l string1: For modes 0 and 1, this is a string that contains the result of the operation.

l If amatch is found, this is the matching string. If nomatch is found, this is an empty string.

l For mode 2, this is the input string that will be modified.

l expression: A regular expression enclosed in quotes or a string containing a regular expression.

l string2: For modes 0 and 1, this is the source string that will be searched. For mode 2, this is the replacement
string that will be inserted in string1.

l n: Functionmode. This is a two-digit value. The right digit has a value of 0, 1, or 2 and is required:

l 0: Search string2 and test if any part matches expression. Return the matching substring in
string1, or an empty string if nomatch.

l 1: Test if the entire string2matches expression. Return original string if match, or empty string if
nomatch.

l 2: Replace string. If any part of string1matches expression, replace that portion of string1with
string2.

The left digit is optional. If the regular expression contains several blocks of sub-expressions within par-
entheses, you can use this digit to target one of the sub-expressions.

The regex( ) function sets the helper variables st_str_ix$ and end_str_ix$with the beginning and ending loc-
ations of the result string.

The following example searches a line of NC output for G1, G2, G3, or G01, G02, G03.

srgx : "G0?[123]" # Find G or G0 followed by either 1, 2, or 3.

sinput : "N1 G01 X1.5 Y1.25 F15."

p_mypostblock

sreturn = regex(srgx, sinput, 0)

The results of the function:

sreturn = "G01"

st_str_ix$ = 4
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end_str_ix$ = 7

Note: The regex( ) function will accept any regular expression.

New Stock Function
Mastercam2019 includes a new stockinfo( ) function for MP. This function allows you to acquire stockmodel inform-
ation from the Model Geometry page for 3D High Speed toolpaths.

The stockinfo( ) function lets you target a specific row for your query. The first argument specifies the query
mode, and the third argument specifies which row to query. The third argument can be either the name of the row
or its number.

The function returns the information from the row as a string with eight items of data. Use rpar( ) or another func-
tion to parse the string and retrieve the desired value.

The string returned by the function contains the following pieces of data:

1 Wall stock.

2 Floor stock.

3 Number of entities.

4 Color. This number is associated with the color in the Mastercam interface.

5 The number of the row (beginning with 0 for the first row).

6 Reserved for future use. This is always 0.

7 Reserved for future use. This is always 0.

8 The name of the row.

For example, the following string is returned when you query the secondmachining Geometry rowpictured above:

0.1 0.05 3 8 1 0 0 machining - right

The general form is:

string = stockinfo(n, x, y)

where,

l String: The stock parameters encapsulated in a string.

l n: The function state.

l 0: Query drive (machining) rows by rownumber.

l 1: Query check (avoidance) rows by rownumber.
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l 2: Query drive (machining) rows by name.

l 3: Query check (avoidance) rows by name.

l x: The ID of the operation whose stock settings you are querying. Use op_id$ to query the current operation.

l y: Helper variable for the function state—either the number of a row or its name. Note that rownumbers
begin with 0, not 1.

UTF-8 Encoding for MP Posts
InMastercam 2018, we introduced a newXML format for post text. However, the .pst file itself is still encoded as
ASCII text. WithMastercam 2019, the entire .pst (or .mcpost) file is encoded as UTF-8. This improves the support for
post text in languages other than United States English. Mastercamwill automatically make this conversion when
youmigrate or update posts fromearlier versions.

UTF-8 Encoding for NC Output
Mastercam2019 allows you to select the character encoding scheme to use for each buffer or output stream. This
includes:

l The main NC output stream

l Auxiliary output streams (subprg$, auxprg$, extprg$, and lccprg$)

l Text buffers

l NCI files

Main NC Output Stream

A new variable, ncprg$, has been introduced to set the character encoding format for the main NC output stream.
There are two possible values:

l 0 indicates that the NC output will be encoding asWindows code page (ANSI) text. This is the default value. It
is also the only output format supported for versions of Mastercambefore Mastercam 2019.

l 10 indicates that the NC output will be encoded as UTF-8 text. Do this when the control unit on your machine
supports UTF-8 text.

Auxiliary Output Stream

You can also set the character encoding scheme individually for each output stream:

l subprg$

l auxprg$

l extprg$

l lccprg$

To accomplish this, a second digit has been added to indicated character encoding.

l Set this digit to 1 for UTF-8 text.

l Set it to 0 (or omit) for Windows code page (ANSI) text. This is the default value andmatches output from
Mastercambefore Mastercam 2019.
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For example, before Mastercam 2019, you could set subprg$ to 2 to open the sub output file in appendmode.
Beginning inMastercam 2019, you can set subprg$ to 12, which will open the sub output file in appendmode with
UTF-8 text encoding.

Buffers

InMastercam 2019, you can select a text encodingmethod hen you define a string buffer. To do this, a second digit
has been added to parameter 5. For example, in earlier versions of Mastercam, you could open a string buffer with
the following statement:

fbuf 4 0 2 1 1

InMastercam 2019, use 11 for the final parameter to specify that the contents of the buffer will be encoded as UTF-
8 text:

fbuf 4 0 2 1 11

NCI Files

You can select UTF-8 encoding for NCI output. This option is set in the Advanced Configuration utility. If this option is
not selected, the NCI file will be encoded asWindows code page (ANSI) text.
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ATTENTION! UPDATES MAY BE AVAILABLE.
PLEASE REFER TO MASTERCAM.COM/SUPPORT

FOR THE LATEST DOWNLOADS.

https://www.instagram.com/mastercamcadcam/
http://i.youku.com/Mastercam
https://www.instagram.com/mastercamcadcam
https://plus.google.com/u/0/112469607931783596009
https://www.youtube.com/user/MastercamCadCam
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